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Introduction 
About this document 
This document is a manual for replacing the integrated display controller FT1A Touch with the FT1J series. 
 
Related Documents 
Please also refer to the following manuals. 
 FT1A Series SmartAXIS Touch User’s Manual (B-1390) 
 FT1A Series SmartAXIS Ladder Programming Manual (B-1382) 
 WindO/I-NV4 User's Manual (B-1701) 
 Ladder Programming Manual (B-2342) 
 SmartAXIS Hardware Manual (B-2339) 
 
Please download the latest manual from our website. 
HOME >PRODUCTS >OPERATOR INTERFACES >PLC+HMI >FT1J 4.3INCH PLC+HMI 
 
Abbreviations, generic terms, and terms used in this book 

Item Explanation 

FT1A Touch 
This is a general term for the following model numbers: 
FT1A-C12RA-*, FT1A-C14KA-*, FT1A-C14SA-*, FT1A-M12RA-*, FT1A-M14KA-*, 
FT1A-M14SA-* 

FT1A-C The abbreviation for the following model numbers: 
FT1A-C12RA-*, FT1A-C14KA-*, FT1A-C14SA-* 

FT1A-M The abbreviation for the following model numbers: 
FT1A-M12RA-*, FT1A-M14KA-*, FT1A-M14SA-* 

FT1A Touch  
(relay output type) 

The abbreviation for the following model numbers: 
FT1A-C12RA-*, FT1A-M12RA-* 

FT1A Touch  
(transistor output type) 

The abbreviation for the following model numbers: 
FT1A-C14KA-*, FT1A-C14SA-*, FT1A-M14KA-*, FT1A-M14SA-* 

FT1J series This is a general term for the following model numbers: 
FT1J-4F12RAG-*, FT1J-4F14KAG-*, FT1J-4F14SAG-* 

FT1J series 
(relay output type) 

The abbreviation for the following model numbers: 
FT1J-4F12RAG-* 

FT1J series 
(transistor output type) 

The abbreviation for the following model numbers: 
FT1J-4F14SAG-*, FT1J-4F14KAG-* 

HMI Function This refers to the functions based on the screen and settings of the main unit 
created with WindO/I-NV4. 

Control Function This refers to the control function based on ladder programs and settings created 
with WindLDR. 

Project This refers to all data, including screen data, used to operate the main unit, 
created by WindO/I-NV4 and WindLDR launched from WindO/I-NV4. 

 
  

https://us.idec.com/idec-us/en/USD/Operator-Interfaces/PLC%2BHMI/FT1J-4-3inch-PLC%2BHMI/c/FT1J_Series?page=1
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Notes 

When changing the product series of a project, please read this manual carefully and understand the differences in 
functions and performance before proceeding. After changing the product series, please make sure to thoroughly 
check the operation before installing it. In particular, the ladder programs and screen content for the following items 
will need to be modified due to differences in function and performance. 
 

Item Explanation Detail 

Startup Time and 
Performance 

The FT1J series has a longer startup 
time than the FT1A Touch. The 
rendering process will have a shorter 
cycle, but you will need to thoroughly 
check the operation after changing the 
product series of your project. 

Chapter 5 “2.1 Startup time”,  
“2.2 Performance improvement” 

I/O Device 
After changing the product series of the 
project, you will need to manually 
replace the address numbers. 

Chapter 5 “1.1 I/O Device” 

Control Device 

On the FT1A Touch, it is treated as an 
internal device, however, on the FT1J 
series, it is treated as the device 
address of the external device. Thus, 
some setting items cannot be used with 
the FT1J series. 

Chapter 5 “2.3 Control Device” 

Internal Clock 
The method for changing the date and 
time data of the internal clock is 
different. 

Chapter 6 “2.13 Internal Clock” 

For other differences related to software specifications, please refer to Chapter 3 “Software specification 
comparison”. 
 
  



 

 From FT1A Touch to FT1J Replacement Guide iv 

Table of Contents 
Revision History ............................................................................................................ i 
Introduction .................................................................................................................. ii 

About this document .......................................................................................................... ii 
Related Documents ............................................................................................................ ii 
Abbreviations, generic terms, and terms used in this book ..................................................... ii 
Notes  ............................................................................................................................. iii 

Chapter 1 Names of each part 

1 FT1A Touch (relay output type) .............................................................................. 1 
2 FT1A Touch (transistor output type) ....................................................................... 2 
3 FT1J series ............................................................................................................ 3 

Chapter 2 Hardware specification comparison 

1 Appearance ........................................................................................................... 4 
2 Performance Specifications ..................................................................................... 5 

2.1 Display ....................................................................................................................5 
2.2 Touch Panel ............................................................................................................5 
2.3 Backup Data ............................................................................................................6 

3 Interface Specifications .......................................................................................... 6 
3.1 Cartridge Slot ..........................................................................................................6 
3.2 Input terminal .........................................................................................................6 
3.3 Output terminal .......................................................................................................8 

4 General Specifications ............................................................................................ 9 

Chapter 3 Software specification comparison 

1 HMI Function ....................................................................................................... 10 
2 Control Function .................................................................................................. 11 

2.1 List of corresponding command differences .............................................................. 12 
3 Internal Device .................................................................................................... 12 

3.1 HMI device ............................................................................................................ 12 
3.2 Control Device ....................................................................................................... 13 

Chapter 4 Replacement Procedure 

1 Converting a project (*.nft to *.pn4) ..................................................................... 14 
2 Download ............................................................................................................ 15 

Chapter 5 Adjustments after project conversion 

1 Control Functions ................................................................................................. 16 
1.1 I/O Device ............................................................................................................. 16 
1.2 Function Settings ................................................................................................... 16 
1.3 Clock-related function............................................................................................. 17 

2 HMI Function ....................................................................................................... 17 
2.1 Startup time .......................................................................................................... 17 
2.2 Performance improvement ...................................................................................... 18 
2.3 Control Device ....................................................................................................... 19 
2.4 Parts ..................................................................................................................... 20 
2.5 Base screen overlay ............................................................................................... 20 



 

 From FT1A Touch to FT1J Replacement Guide v 

2.6 Installed Fonts in the Main Unit ............................................................................... 21 
2.7 Prohibited characters ............................................................................................. 22 
2.8 Communication Driver ............................................................................................ 22 

Chapter 6 Other specification differences 

1 Main unit operation specifications ......................................................................... 23 
1.1 Control function operation ...................................................................................... 23 
1.2 Changing timer and counter settings ....................................................................... 24 
1.3 Resetting after switching to System Mode ................................................................ 24 
1.4 Clear after download .............................................................................................. 24 

2 WindO/I-NV3 and WindO/I-NV4 ............................................................................ 25 
2.1 Ribbon > Configuration tab .................................................................................... 25 
2.2 Ribbon > Online tab ............................................................................................... 25 
2.3 Protocol Manager ................................................................................................... 25 
2.4 Screen window alignment ....................................................................................... 25 
2.5 Print Function ........................................................................................................ 26 
2.6 Text Manager ........................................................................................................ 26 
2.7 Library Screen ....................................................................................................... 26 
2.8 Grouping of object lists .......................................................................................... 26 
2.9 Setting characters and device addresses .................................................................. 26 
2.10 Terms ................................................................................................................... 26 
2.11 Cartridge Settings .................................................................................................. 27 
2.12 System software version number ............................................................................ 27 
2.13 Internal Clock ........................................................................................................ 27 

3 Downloader and Data File Manager ....................................................................... 27 

Chapter 7 References 

1 Terminal arrangement and wiring example ............................................................ 28 
1.1 FT1A Touch ........................................................................................................... 28 
1.2 FT1J series ............................................................................................................ 29 

2 Rules for Converting to the top layer ..................................................................... 31 
 
 
 



 

 From FT1A Touch to FT1J Replacement Guide 1 

Chapter 1 Names of each part 
1 FT1A Touch (relay output type) 

 
No. Name 

(1) Display 

(2) Touch Panel 

(3) Power Supply terminal (24V DC) 

(4) Serial Interface (Port) 

(5) Ethernet Interface (Ethernet) 

(6) USB interface (USB1) 

(7) USB interface (USB2) 

(8) Output terminals (Q0 to Q3) 

(9) Input terminals (I0 to I7) 
 
  

③ 

①② 

④ 
⑤ 

⑥ 

⑦ 

⑧ ⑨ 
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2 FT1A Touch (transistor output type) 

 
No. Name 

(1) Display 

(2) Touch Panel 

(3) Power Supply Terminal (24V DC) 

(4) Serial Interface (Port) 

(5) Ethernet Interface (Ethernet) 

(6) USB interface (USB1) 

(7) USB interface (USB2) 

(8) Output terminals (Q0 to Q3, AQ0, AQ1) 

(9) Input terminals (I0 to I7) 

(10) Cartridge slot (Slot1) 

(11) Cartridge slot (Slot2) 

 
  

①② 

⑤ 

③ 

④ ⑧ ⑨ 

⑦ 

⑥ ⑪ ⑩ 
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3 FT1J series 

 
No. Name 

(1) POWER LED 

(2) Display 

(3) Touch Panel 

(4) Serial Interface (COM) 

(5) USB interface (USB1) 

(6) USB interface (USB2) 

(7) Ethernet Interface (LAN) 

(8) Power Supply Terminal 

(9) Mounting Clip Position 

(10) RESET Switch 

(11) Input Terminal (IN) 

(12) Output Terminal (OUT) 

(13) Cartridge Slot (Slot1) 

(14) Cartridge Slot (Slot2) 
 
 

① 

③ ② 

⑧ 

⑥ ⑤ 

④ ⑦ 
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Chapter 2 Hardware specification comparison 
1 Appearance 

Item FT1A Touch 
(Relay output type) 

FT1A Touch 
(Transistor output type) FT1J series 

External Dimension 116.0(W)x77.0(H)x57.7(D)
mm 

116.0(W)x77.0(H)x58.9(D)
mm 

123.8(W)x86.5(H)x58.9(D)
mm 

Panel Cut-Out 

104.5(W)x65.5(H)mm 112.8(W)x75.5(H)mm 

Mounting Clip Position 2 locations 

Power Supply Terminal Screw-fastening type Push-in type 

Serial Interface Terminal Screw-fastening type Push-in type 
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2 Performance Specifications 
Item FT1A Touch FT1J series 

Display See Chapter 2 “2.1 Display” 

Touch Panel See Chapter 2 “2.2 Touch Panel” 

User Memory Capacity Approximately 5MB Approximately 24MB 

Backup Data See Chapter 2 “2.3 Backup Data” 
 
2.1 Display 

Item FT1A-M FT1A-C FT1J series 

LCD Type STN Monochrome LCD TFT Color LCD TFT Color LCD 

Display Color 2 Colors (Black, White)  
8 shades 65,536 colors 16,777,216 colors 

Effective Display Area 87.59(W)x35.49(H) mm 88.92(W)x37.05(H) mm 95.04(W)x53.856(H) mm 

Display Resolution 240(W)x100(H) pixels 480(W)x272(H) pixels 

Screen Size (Aspect Ratio) 12:5 16:9 

Dot Pitch (Aspect Ratio) 1:1 

View Angle Left/Right/Top/Bottom: 45° Left/Right: 40°  
Top: 20° Bottom: 60° 

Left/Right/Top/Bottom: 
80° 

Contrast Adjustment 32 levels None 

Brightness of LCD only White: 740cd/㎡ 
Red: 135cd/㎡ 400cd/㎡ 500cd/㎡*1 

Brightness adjustment 32 levels 

Backlight 
LED (White, Red) 

Screen color: White, Pink, 
Red 

LED (white) 

Backlight Life Approx. 50,000 hours 

 
2.2 Touch Panel 

Item FT1A Touch FT1J series 

Switch Type Analog Resistive Film Projected Capacitive 

Operating touch panel while wearing gloves Possible For gloves less than 1.5mm thick, possible 

Multiple Operations Impossible Possible (2-point touch) 

 
  

 
*1 The FT1J series utilizes a high-transparency cover with a glass-coated touch panel, resulting in a brighter appearance compared to 

previous models in terms of perceived brightness. 
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2.3 Backup Data 

Item FT1A Touch FT1J series 
Clock data retention period  

(operating ambient temperature 25°C) 
Approximately  

30 days 
Approximately 20 days 

(held by a large-capacity capacitor) 
Retention period of log data, HMI Keep Relay, HMI 

Keep Register, Internal Relay, Shift Register, counter, 
data register (operating ambient temperature 25℃) 

Approximately  
30 days 

No deadline 
(stored in non-volatile memory) 

Battery life  
(model case: 9 hours charge, 15 hours discharge) 5 years No batteries required*1 

 

3 Interface Specifications 
Item FT1A Touch FT1J series 

Serial Interface Removable terminal block 9 pin 
RS232C: 1ch, RS422/485: 1ch 

Removable terminal block 10 pin 
RS232C: 1ch, RS422/485: 1ch 

Ethernet Interface Yes (printed: Ethernet) Yes (printed: LAN) 

USB Interface 
Mini-B (printed: USB1) Type A (printed: USB1) 

Type A (printed: USB2) 
Maintenance 

Communication 
USB1, Ethernet: Supported 

USB2: Not supported 
LAN: Supported 

USB1, USB2: Not supported 
Cartridge Slot See Chapter 2 “3.1 Cartridge Slot” 

Input terminal See Chapter 2 “3.2 Input terminal” 

Output terminal See Chapter 2 “3.3 Output terminal” 
 
3.1 Cartridge Slot 

Item FT1A Touch 
(Relay output type) 

FT1A Touch 
(Transistor output type) FT1J series 

Number of Cartridge Slots none 2 

Compatible Cartridges none 

FC6A-PN4, 
FC6A-PTS4, FC6A-PTK4, 
FC6A-PJ2A, FC6A-PJ2CP, 

FC6A-PK2AV, FC6A-PK2AW 
 
3.2 Input terminal 

Item FT1A Touch FT1J series 
Input Points 8 points 
Digital Input See Chapter 2 “Digital Input” 
Analog Input See Chapter 2 “Analog Input” 

For wiring examples, see Chapter 7 “1 Terminal arrangement and wiring example”. 
 
  

 
*1 For the FT1J series, there is no checkbox for Enable Low Battery Warning on the System tab of the Project Settings dialog box of 

WindO/I-NV4. 
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● Digital Input 

Item FT1A-*12RA-*, 
FT1A-*14SA-* FT1A-*14KA-* FT1J-4F12RAG-*, 

FT1J-4F14SAG-* FT1J-4F14KAG-* 

Input Circuit Type Sink input Source input Sink input Source input 
Input Points 

(Terminal No. 
/Common Line 

Name) 

6 points  
in 1 common line 
(I0 to I5/Power 

supply(+) terminal) 

6 points  
in 1 common line 
(I0 to I5/Power 

supply(-) terminal) 

6 points  
in 1 common line 
(I0 to I5/Power 

supply(-) terminal) 

6 points  
in 1 common line 
(I0 to I5/Power 

supply(+) terminal) 
 
● Analog Input 

Item FT1A Touch 
(Relay output type) 

FT1A Touch 
(Transistor output type) FT1J series 

Input Electrical Characteristic Voltage (0 to 10V DC) Voltage or current (0 to 10V DC/4 to 20mA) 

Input Points*1 
(Terminal Number) 

2 points 
in 1 common line  

(I6, I7/Power 
supply(-) terminal) 

2 points 
(AI0+, AI1+/AI0-, AI1-) 

2 points 
(I12, I13/COM0(-) terminal, 

COM1(-) terminal) 

Digital Resolution 1000 (10bit) 4096 (12bit) 

Data Type Binary data: 0 to 1000 
Binary data: 0 to 4095 

Optional range:  
-32768 to 32767 

AD 
Conversion 

Sampling Time 2 ms max. 5 ms max. 
Sampling 
Repetition 

Time 
2 ms max. 5 ms max. 

Total Input 
Delay Time 

Varies depending on input electrical characteristics 
Voltage: 3 ms+1 filtering time+1 scan time 
Current: 12 ms+1 filtering time+1 scan time 

6 ms+1 scan time 

 
● Pulse Input 

Item FT1A Touch FT1J series 

High-speed 
Counter 

Maximum frequency of single-phase high-speed counter 10kHz 20kHz 
Maximum frequency of two-phase high-speed counter 

(2-edge count) 5kHz 10kHz 

Maximum frequency of two-phase high-speed counter 
(4-edge count) 2.5kHz 5kHz 

Catch Input 
Minimum Pulse Width On Time 50μs 25μs 
Minimum Pulse Width Off Time 50μs 25μs 

Frequency 
Measurement Measurement range 200Hz to 10kHz 1Hz to 20kHz 

 
  

 
*1 Digital input shared 
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3.3 Output terminal 

● Digital Output 
Relay Output 

Item FT1A Touch (relay output type) FT1J series (relay output type) 

Output Points (Terminal Number) 4 points (Q0 to Q3) 

Maximum Load Current 10A 1 point 2A or less,  
1 common line 2A or less 

Minimum Switching Load 10mA, 5V DC (reference value) 1mA, 5V DC (reference value) 

Initial Contact Resistance 100mΩ max. 30mΩ max. 

Rated Load Current 250V AC 10A, 30V DC 10A 240V AC 2A, 30V DC 2A 

 
Relay output delay 

 
Item FT1A Touch (relay output type) FT1J series (relay output type) 

ON delay 6ms maximum 10ms maximum 
ON Bounce 6ms maximum 1ms maximum 
OFF Delay 330ms maximum 10ms maximum 

OFF Bounce - 1ms maximum 
 
Transistor Output 

Item FT1A-*14KA-* FT1A-*14SA-* FT1J-4F14KAG-* FT1J-4F14SAG-* 
Output Circuit Type Sink output Source output Sink Output Source Output 

Output Points 4 points (Q0 to Q3) 
Maximum Load Current 0.3A 1 point 0.5A, 1 common line 2A 

 
● Analog Output 

Item FT1A Touch  
(transistor output type) 

FT1J series  
(transistor output type) 

Output Electrical Characteristics Voltage/Current (0 to 10 V DC / 4 to 20mA DC) 
Output Points 2 points 

Digital Resolution 1000 (10bit) 4096 (12bit) 

Data Format Binary data: 0 to 1000 Binary data: 0 to 4095 
Optional range: -32768 to 32767 
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4 General Specifications 

Item FT1A Touch 
(Relay output type) 

FT1A Touch 
(Transistor output 

type) 
FT1J series  

(Relay output type) 
FT1J series  

(Transistor output 
type) 

Ambient 
Temperature 

FT1A-M: 0 to +55°C (no freezing) 
FT1A-C: -20 to +55°C (no freezing) -20 to +55℃(no freezing)*1 

Rated Voltage DC24V 

Power 
Consumption 

9.2W max. 
When USB2 is unused: 

5.8W max. 

10.1W max. 
When USB2 is unused: 

8.1W max. 
 

13W max. 
When USB1, USB2, IN, 
OUT, Slot1, Slot2 are 

unused: 5W max. 
And when backlight is 

OFF: 3W max. 

15W max. 
When USB1, USB2, IN, 
OUT, Slot1, Slot2 are 

unused: 5W max. 
And when backlight is 

OFF: 3W max. 
Inrush Current 50A max. 40A max. 

Startup Time 3 Seconds 13 Seconds 
External 
memory USB memory 

 
 

 
*1 The upper limit of the output current of the USB interface varies depending on the installation orientation and the ambient temperature 

during use. For more information, please refer to the SmartAXIS Hardware Manual (B-2339). 
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Chapter 3 Software specification comparison 
Item FT1A Touch FT1J series 

Maximum size of 
project data 

HMI function: 5,177,344 bytes 
Control function: 94,800 bytes 

HMI function: 25,165,824 bytes 
Control Function: 124,928 bytes 

HMI Function See “1 HMI Function” 

Control Function See “2 Control Function” 

Internal Device See “3 Internal Device” 
 

1 HMI Function 
Item FT1A Touch FT1J series Detail 

Startup time 3 seconds 13 seconds Chapter 5 “2.1 Startup 
time” 

Performance 
Due to the significant improvement over 
the FT1J series, there are some points to 

note. 

Chapter 5 “2.2 
Performance 

improvement” 

Internal processing of the control device Equivalent to HMI 
device 

Equivalent to the 
device address of 

the external device 

Chapter 5 “How the 
control device is 

handled internally” 
Data storage area 102,400 bytes 112,640 bytes - 

Drawings Fill Supported Not supported 

The object (Fill) will be 
deleted, so please 

replace it with another 
object if necessary. 

Parts 

Selector Switch, 
Potentiometer Supported Not supported Chapter 5 “Selector 

Switch, Potentiometer” 
Recover Background 
for Pilot Lamp, Multi-

State Lamp, and Picture 
Display 

Supported Not supported 
Chapter 5 “Pilot Lamp, 

Multi-State Lamp, 
Picture Display” 

Rendering of overlay screens Differences may occur if certain 
conditions are met. 

Chapter 5 “2.5 Base 
screen overlay” 

Tag Editor Tag name containing 
colon Possible impossible Chapter 5 “Tag Name” 

File names, 
folder names, 

and commands 

Certain symbol 
characters, two 

consecutive periods 
Possible Impossible Chapter 5 “File and 

folder name” 

Built-in fonts Bitmap Fonts Outline Fonts 
Chapter 5 “2.6 

Installed Fonts in the 
Main Unit” 

Communication 
Driver 

Koyo Supported Not supported 
Chapter 5 “2.8 
Communication 

Driver” 

YOKOGAWA Supported Not supported 
Hitachi Industrial 

Equipment Systems Supported Not supported 
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2 Control Function 
Item FT1A Touch FT1J series Detail 

Supported Programs Ladder Program 
FBD Program Ladder Program 

After the change, the 
FBD program is 

deleted, and an empty 
ladder program is 

created. 

Minimum execution interval 5ms - Chapter 6 “FT1A 
Touch” 

Ladder Program 
Week Programmer 
instruction (WEEK, 

YEAR) trigger conditions 
none M8022 has a 

value of 1 

Chapter 5 “Week 
Programmer instruction 

(WEEK, YEAR)” 
Digital I/O 
Cartridge Address Number Range I10 to I17 

Q4 to Q7 
I20 to I27 

Q10 to Q17 
Chapter 5 “1.1 I/O 

Device” 

Memory Backup 
Counter Clear Specified 

Range 
Keep Specified 

Range 
Chapter 5 “1.2 

Function Settings” Data Register 
High-Speed 

Counter  
> Group 5 

Frequency 
Measurement Supported Not supported Chapter 5 “1.2 

Function Settings” 

Analog Input, 
Analog Output Data Format Binary Data Binary data, 

Optional range 
Chapter 5 “1.2 

Function Settings” 

Ladder Program Monitor Supported Not supported*1 Chapter 5 “1.2 
Function Settings” 

Watchdog Timer Maximum 5000ms 4000ms Chapter 5 “1.2 
Function Settings” 

Daylight Saving Time Set using WindLDR Set using 
WindO/I-NV4 

Chapter 5 “Daylight 
Saving Time” 

Timing when clock-related functions can be 
executed After boot After the HMI 

function is started 

Chapter 5 “Week 
Programmer instruction 

(WEEK, YEAR)” 

Remote I/O Supported Not supported*2 
Chapter 5 “1.2 

Function Settings” 
 
  

 
*1 The FT1J series does not have an LCD Settings tab in the Function Area Settings dialog box of WindLDR. 
*2 The FT1J series does not have a Connection Settings tab in the Function Area Settings dialog box of WindLDR. Remote I/O can be 

achieved by combining with the SX8R series. 
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2.1 List of corresponding command differences 

For details about the corresponding instructions, see the programming manual in "Related Documents". Below is the 
list of the differences between the FT1A Touch and FT1J series. 
 
● Calculation Instruction 

Item FT1A Touch FT1J series 

Binary Arithmetic RNDM Not supported Supported 

Program Branching FRQRF Not supported Supported 

Week Programmer YEAR 
WEEK Supported Supported*1 

Pulse PULS 
PWM Not supported Supported 

PID Instruction 
PIDA Supported*2 Supported 

PIDD Not supported Supported 

Flow 
FLWP 
SCALE 
FLWA 

Not supported Supported 

 
● Macro Instructions 

Item FT1A Touch FT1J series 

UMACRO Not supported Supported 
 

3 Internal Device 
The internal device address number ranges are different. 
 
3.1 HMI device 

● Bit Device 
Device Type FT1A Touch FT1J series 

LM (HMI Internal Relay) 0 to 2047 0 to 4095 

LK (HMI Keep Relay) Variable 

LTC (HMI Timer Contact) 0 to 31 

LBM (HMI Temporary Relay) 0 to 127 0 to 255 

LSM (HMI Special Internal Relay) 0 to 63 0 to 127 
 
  

 
*1 Trigger conditions must be fulfilled. For details, see Chapter 5 “Week Programmer instruction (WEEK, YEAR)”. 
*2 The function of the PID command of the FT1A Touch is equivalent to that of the PIDA command of the FT1J series. 
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● Word Device 
Device Type FT1A Touch FT1J series 

LDR (HMI Data Register) 0 to 8191 0 to 16383 

LKR (HMI Keep Register) Variable 

LTD (HMI Timer Current Value) 0 to 31 

LBR (HMI Temporary Register) 0 to 127 0 to 255 

LSD (HMI Special Data Register) 0 to 255 0 to 511 
 
3.2 Control Device 

● Bit Device 
Device Type FT1A Touch FT1J series 

I (Input) 

Built-in  0 to 5 

Built-in (Analog common) 6 to 7 12 to 13 (IOREF not available) 

Cartridge slot (Slot1) 10 to 13 20 to 23 

Cartridge slot (Slot2) 14 to 17 24 to 27 

Q (Output) 

Built-in 0 to 3 

Cartridge slot (Slot1) 4 to 7 10 to 13 

Cartridge slot (Slot2) 10 to 13 14 to 17 

M (Internal Relay) 0 to 1277 0 to 7997 

M (Special Internal Relay) 8000 to 8177 

R (Shift Register) 0 to 127 

T (Timer Contact) 0 to 199 

C (Counter Contact) 0 to 199 
 
● Word Device 

Device Type FT1A Touch FT1J series 

TC (Timer Current Value) 0 to 199 

TP (Timer Preset Value) 0 to 199 

CC (Counter Current Value) 0 to 199 

CP (Counter Preset Value) 0 to 199 

D (Data Register) 0 to 1999 0 to 3999 

D (Special Data Register) 8000 to 8199 

P (Index Register) Not supported 0 to 151 
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Chapter 4 Replacement Procedure 
1  Execute the product series change in the project. 

(⇒ “1 Converting a project (*.nft to *.pn4)”) 

2  Edit the project. 
(⇒ Chapter 5 “Adjustments after project conversion”) 

3  Download the project to the FT1J series. 
(⇒ “2 Download”) 

 
For differences in software specifications between the FT1A Touch and FT1J series, please refer to Chapter 6 
“Other specification differences". However, there is no need to take these differences into account when following 
the replacement procedure mentioned above. 
 

1 Converting a project (*.nft to *.pn4) 
1  Prepare the project (*.nft) to be replaced. 

If the project (*.nft) is in the FT1A Touch, upload it using Windo/I-NV3 and back up the project (*.nft). 

2  Start the WindO/I-NV4 version 3.1.0 or later. 
The Select Product Series dialog box is displayed. 

3  Click Cancel to close the Select Product Series dialog box. 

4  Click the application button and then click Open. 
The Open dialog box is displayed. 

5  In the drop-down list to the right of the File name, select “WindO/I-NV3 Project (*.nft)”. 
The project (*.nft) is displayed in the main window. 

 
6  Select the project (*.nft) prepared in step 1 and click Open. 

The Change Product Series dialog box is displayed. 

7  In the Set Conversion Option, make sure that Zooming Conversion is selected, and click OK. 
A warning message is displayed. 

8  Check the message and click OK. 
The Destination path for Convert dialog box is displayed. 

9  Specify the file name after the data conversion and click Save. 
Data conversion starts. 

10 When the data conversion is complete, click Close. 
The converted project is displayed. 

11 Edit the project. 
For setting items that need to be edited after the conversion, please refer to Chapter 5 “Adjustments after 
project conversion”. 
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2 Download 
Download the converted project to the FT1J series. 

1  Connect the computer and the FT1J series with an Ethernet cable. 

2  On the WindO/I-NV4 Online tab, under Transfer, click Download. 
The Download dialog box is displayed. 

3  Click Comm. Settings… button. 
The Communication Settings dialog box is displayed. 

4  In Network Adapter, select the network adapter*1 to be used for communication, and click OK. 
You are returned to the Download dialog box. 

5  Click the Search button. 
Information about the FT1J series found through a search on the network will be displayed in the list. 

6  Select the check box for the FT1J series you want to download from the list and click Download. 
Download starts. However, the project is downloaded only if the PC and FT1J are on the same subnetwork*2. 

 

 
*1 You can check your network adapter from Windows Control Panel > Network and Sharing Center > Change adapter settings. 
*2 If the PC and FT1J are not on the same subnetwork, a confirmation message is displayed. Click Yes on the confirmation message, then 

click Yes in the User Account Control dialog box to display an information message stating that an IP address has been added to your 
computer. Click OK on the information message and the download begins. 
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Chapter 5 Adjustments after project conversion 
1 Control Functions 

1.1 I/O Device  
Each I/O Device has a different device address assignment. After changing the product series, please replace the 
address number manually. 

Device Type FT1A Touch FT1J series 

I（Input） 

Built-in 0 to 5 0 to 5 
Built-in (Analog common) 6 to 7 12 to 13 （IOREF not available） 

Cartridge Slot (Slot1) 10 to 13 20 to 23 
Cartridge Slot (Slot2) 14 to 17 24 to 27 

Q（Output） 
Built-in 0 to 3 0 to 3 

Cartridge Slot (Slot1) 4 to 7 10 to 13 
Cartridge Slot (Slot2) 10 to 13 14 to 17 

 
1.2 Function Settings 
The setting items that differ depending on the product series are as follows. Please check the results of the product 
series change. 

Function Settings 
FT1A Touch 

(Relay output 
type) 

FT1A Touch 
(Transistor 

output type) 
FT1J 

series 
Results of 

changing device 

Memory Backup 

Counter 

Clear Specified Range 
Keep 

Specified 
Range 

It will be “keep 
everything”. Please 

check if this will have 
any impact on your 
project operation. 

Data Register 

Input/Output*1 

Special Input  
> Group 5  

> Frequency 
Measurement 

Supported Not 
supported 

It will become 
“normal input” and all 
related settings will be 
deleted. Please check 
if this will have any 

impact on your project 
operation. 

Analog/Digital 
Input 0 to 1000 (fixed) 0 to 4095 

(fixed) or 
"arbitrary" 

This can be 
“arbitrarily specified” 

from “0 to 1000”. Analog Output - 0 to 1000 (fixed) 

LCD Settings 

Ladder Program 
Monitor  

> Enable ladder 
program monitor 

on FT1A 

Supported Not 
supported 

It cannot be 
monitored on the 

main unit screen. Use 
the Monitor in the 

Online tab of 
WindLDR. 

Self Diagnostic 
Watchdog Timer 

Settings  
> Watchdog Timer 

Maximum 5000ms Maximum 
4000ms 

Any value greater 
than 4000ms will be 
changed to 4000ms. 

Connection 
Settings Connections Supported Not 

supported 

The number of I/O 
points on the main 

unit cannot be 
expanded. 

 
  

 
*1 FT1A Touch (relay output type) is Input 
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1.3 Clock-related function 

Clock data is handled differently. With the FT1A Touch, the clock-related functions of the HMI functions are set in the 
HMI function settings, and the clock-related functions of the control functions are set in the control function settings. 
In the FT1J series, the clock data is managed by the HMI function, so the control function cannot handle the clock 
data until the HMI function has started. 
If you are using the following functions, please manually correct the various settings after changing your device. 
 Daylight Saving Time 
 Week Programmer instruction (WEEK, YEAR) 
 Instructions that use clock data 
 
● Daylight Saving Time 
Daylight saving time can be set in the following places: 
FT1A Touch: WindLDR Calendar & Clock in the Function Area Setting dialog box  
FT1J: WindO/I-NV4 Project Settings dialog box, Internal Clock tab  
 
● Week Programmer instruction (WEEK, YEAR) 
When executing the WEEK or YEAR instruction on the FT1J, the HMI function must be running. 
Set these commands to be executed when the HMI function startup completion flag (M8022) is set to 1. When the 
value of M8022 is 0, executing these instructions will result in the value of D1 (output) being 0. 
 

2 HMI Function 
2.1 Startup time 
The FT1J series has a longer startup time than the FT1A Touch. 
Adjust your project so that an additional 10 seconds of SmartAXIS startup time does not impact your system. 
 
With the FT1J series, you can start operating the control function without waiting for the HMI function to start up. 
To enable this function, select Run/Stop Control in the Function Area Setting dialog box of WindLDR, and check 
the Start running immediately when power on check box under RUN/STOP Selection at Power Up. 
However, if you select the Start running immediately when power on check box, please be careful when 
handling the clock data. For details, see “1.3 Clock-related function”  

 
The FT1J series displays a black screen by default until the HMI function starts up. To display an alternative image, 
select the Display a Picture at Startup check box on the System Settings tab of the WindO/I-NV4 Project 
Settings dialog box, and then set the image you want to display. 
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2.2 Performance improvement 

The FT1J series has a dual CPU configuration, which means that its processing speed is significantly faster than that 
of the FT1A Touch (single CPU configuration), so processes such as reading and writing device address values of 
external devices and screen rendering processes are executed in shorter cycles. 

 
The overview of the process for reading and writing the device address value of an external device using the HMI 
function is as follows: 
1) The read or write request is stored in a queue. 
2) When a request is ready to be sent, the CPU gets the next request from the queue and sends it. 
 
With the FT1J series, the frequency of 1) occurring will be higher than with the FT1A Touch, but because the 
processing speed of the external device does not change, the frequency of 2) occurring will be the same as when the 
FT1A Touch was being used. Therefore, if you have a project in which you frequently run global scripts or script 
commands that read and write large amounts of device address values for external devices on the FT1A Touch, the 
queue waiting to be sent may overflow after conversion to the FT1J series, and, for example, operations on the 
touch panel may not be accepted. In this case, please reduce the number of device addresses of the external devices 
that you want to read from or write to, extend the execution period of the global script, script command, or do both. 
 
The following table summarizes the differences in the process of reading and writing the device address values of 
external devices, an issue that may result from these differences, and how to resolve them. 

Item FT1A Touch FT1J series 

Differences in the process of 
reading and writing the device 

address the value of an external 
device 

1) Read/write 
queue storage Slow Fast 

2) Send queue 
execution Same (depends on external device) 

An issue that may result from the differences Operation on the touch 
panel is possible 

Operation on the touch panel is not 
possible 

How to resolve the issue - 

Reduce script reading and writing 
points. 

Extend the execution period of the 
script. 

 
Moreover, in the FT1J series, the screen rendering process and communication with external devices are executed 
asynchronously. So if the FT1A Touch project is created based on the assumption that the device address of a 
specific external device changes during the first and second screen scans, the converted FT1J series project may 
result in a different behavior; the value of the device address may stay the same on both scans. In such cases, you 
can resolve this by using countermeasures like extending the time between the first and second scans with a timer 
command. 
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2.3 Control Device 

● How the control device is handled internally 
In the FT1A SmartAXIS Touch User's Manual (B-1390) and the WindO/I-NV4 User's Manual (B-1701), the control 
device is described as an "internal device" just like the HMI device. However, FT1A Touch internally treats the control 
device as an internal device. As for the FT1J series, a control device is treated as a device address of the external 
device. Consequently, with the FT1J series, you cannot set the control device to settings that don’t allow the device 
address of the external device. You must set the HMI device instead. 
 
Following settings must set HMI device after changing the product series 

Dialog Box Tab Setting Item Name 

Project Settings 

Communication 
Interface 

Interface Configuration: 
Ethernet > Protocol#  

> Function: User 
Communication# 

Specify the IP address and port number 
as the device address value. 

Communication 
Driver 

Manufacturer: other than 
Not used 

Ignore communication errors and 
continue operation 

Batch monitoring the communication 
error information for all Station Numbers 

Monitoring communication error 
information for each station, individually 

User 
Communication 

Command List  
> Command Settings Dialog 

Box 

Completed Device Address 

Status Device Address 

Trigger Condition*1 

Data List > Data Setting 
Dialog Box  

> Type: Device Address 

Device Address 

Use Reference Device Address 

Variable 
Data List > Data Setting 

Dialog Box > Data Setting  
> Type: Registered Constant 

Index Device Address 

Alarm Log Settings General 
Monitor How Many Times Each Alarm has occurred 

Monitor the state of Each Alarm 

Data Log Settings > 
Individual Settings Option 

Copy Data Log Data Destination Device Address 

Starting Point Specify by Value of Device Address 

Number of data Device Address 

Target Data Start number, End number 
Operation Log 

Settings General Trigger Conditions Device Address 

Preventive 
maintenance 

settings  
> Individual settings 

Operation time 

Measure Operation time 
Report when Operating Time 

has reached or exceeded 
Threshold level 

Level #: Threshold 

Report Device Address 

Number of 
operations 

Measure Operation count 
Report when Operation 
Count has reached or 

exceeded Threshold level 

Level #: Threshold 

Report Device Address 

 
 

 
*1 With WindO/I-NV3, you were able to set the device address of the external device, but this is a bug in WindO/I-NV3. 
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2.4 Parts 

● Selector Switch, Potentiometer 
The FT1J series does not support a selector switch and potentiometer. To reproduce a screen using a selector switch 
or potentiometer on the FT1J series, please use the "Selector Switch" or "Slider Switch" in the sample library of the 
parts library or combine other parts to create a part with similar functionality. 
 
● Pilot Lamp, Multi-State Lamp, Picture Display 
The FT1A Touch has a Pilot Lamp, Multi-State Lamp, and Picture Display with Recover Background checkbox. The 
behaviors of the display when Recover Background checkbox is selected and cleared are as follows: 

 
In the FT1J series, the background is always recovered to its original state (it is the same as if the check box was 
selected). If you have created screens with parts or drawings placed in the background by unchecking the Recover 
Background check box for parts in the project before the product series change, change the background settings as 
necessary. 
 
 
2.5 Base screen overlay 

● Rendering the top layer 
When changing to the FT1J series, objects that meet the conditions described in Chapter 7 “2 Rules for Converting to 
the top layer” are automatically placed on the top layer. Also, when overlaying screens are rendered, the objects on 
the top layer are drawn together later, as shown on the right side of the following illustration.  

 
Therefore, if there is an object that is automatically placed on the top layer on a base screen with overlaying screens 
set, the display may differ from that of the FT1A Touch screen. 
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● Rendering of overlaying parts on different base screens 
When parts are overlaid as a result of Overlay with Base Screen, the rendering process for the parts behind 
screens will be different when the part in front goes from visible to hidden. On the FT1A Touch, parts in the 
background are fully displayed. However, on the FT1J, if the Place on the Top Layer checkbox is cleared, 
overlapping background parts may be cut off by those in the foreground. 

 
2.6 Installed Fonts in the Main Unit 
The FT1A Touch comes with Japanese, Western, and High-quality Western fonts pre-installed, but any other fonts 
must be downloaded as extension fonts. With the FT1J series, all fonts are pre-installed at the time of shipment*1, so 
there is no need to download them. Additionally, the fonts have been changed from bitmap fonts to outline fonts, so 
fonts maintain consistent quality when scaled up or down. To maintain this advantage, line spacing adjustment is 
added for accurately reproducing the display of multi-line text with bitmap fonts. 
Other differences from the FT1A Touch are as follows: 
 Size of the font is specified by points, not by magnification. 
 The Size of “16x16” for numeric input, text input, numeric display, and clock is not supported. 
 "Bold" and "Shadow" are not supported. 
 
When changing product series, the font size and line spacing will be automatically adjusted to match the previous 
bitmap font size as much as possible. However, incompatible settings will be replaced with default values, so after 
changing the product series, please check that the text on each screen is adjusted appropriately and change the size 
and space between lines as necessary. 
 
 
  

 
*1 For the FT1J series, there is no Use Large Font check box on the System tab of the Project Settings dialog box of WindO/I-NV4. 
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2.7 Prohibited characters 

● Tag Name 
In WindO/I-NV4 Ver. 3.0.0 or later, tag names containing a colon cannot be set. Please set a tag name that does not 
contain a colon. 
 
● File and folder name 
The following characters cannot be used in file and folder names: 

Item FT1A Touch FT1J series 

File name ¥ / : , ; * ? " < > | ¥ / : ; * ? " < > | # & $ ' ( ) ` ~ 
Two consecutive periods 

Folder name All symbols ¥ / : ; * ? " < > | # & $ ' ( ) ` ~ . 

 
The characters listed below cannot be used in the following file names, folder names, and commands. 

Dialog Box Tab Setting Item Name 

Project Settings External Memory Device External Memory Device Folder 

Alarm Log Settings External Memory Device 
Batch File name 

Real Time File name 

Data Log Settings External Memory Device 
Batch File name 

Real Time File name 

Operation Log Settings External Memory Device  
Batch File name 

Real Time File name 
Recipe Settings  

> Individual Settings Block Access to: External Memory Device File name 

Picture Manager File name 

Key Button Data Transfer 
Download Project Source 

Upload Project Destination 
 

file section Command  

USB autorun definition file 
(hgauto.ini) [COMMAND] 

command = PRO_DOWNLOAD src_path*1 

command = PRO_UPLOAD dst_path*1 
 
2.8 Communication Driver 
The FT1J does not support the following communication drivers: 
After changing the product series, the Manufacturer on the Communication Driver tab of the Project Settings 
dialog box will change to "Not Use" and all related settings will return to their default settings. 

Manufacturer Communication Driver 

Koyo KOSTAC-SUSZ 
DirectLogic (Ethernet) 

YOKOGAWA FACTORY ACE FA-M3 (Ethernet) 

Hitachi Industrial Equipment Systems EH (Ethernet) 
 
 

 
*1 You can use a colon (:) following the drive letter and a backslash (¥) as a path separator. 
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Chapter 6 Other specification differences 
1 Main unit operation specifications 

1.1 Control function operation 

● FT1A Touch 
For each part on the screen, the control function is executed first, then the HMI function (display processing) is 
executed. 
The control function (input refresh + ladder or FBD processing + output refresh) and HMI function (sleep) are 
executed in a single cycle, with the control function running at fixed intervals. This interval is set in the Execution 
Period of Control Function on the System tab of the WindO/I-NV3 Project Settings dialog box. 

 
● FT1J series 
The HMI function and the control function are processed independently.*1 If you want to start the control function 
without waiting for the HMI function to start, select the Start running immediately when power on check box. 

 

 
*1 For the FT1J series, there is no Execution Period of Control Function setting on the System tab of the Project Settings dialog box 

of WindO/I-NV4. 

Start scanning 
for HMI functions 

Start scanning 
for control functions 

Start scanning 
for HMI and 
control functions 

If the checkbox is OFF If the checkbox is ON 
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1.2 Changing timer and counter settings 

You can change the timer and Counter Preset Values by clicking the Confirm button in the TIM/CNT Change 
Status under Operation Status in the PLC Status dialog box of WindLDR. 
However, while monitoring is in progress, you can click this button to change the values on the FT1A Touch, but you 
cannot change it on the FT1J series.*1 
 
1.3 Resetting after switching to System Mode 
When switching from run mode to system mode, the FT1A Touch does not reset the control functions, but the FT1J 
does. 
Therefore, if a ladder program execution error occurs (the value of bit 13 of the Special Data Register (D8005) 
becomes 1), and you switch to system mode and then return to run mode, the value of bit 13 of D8005 will be 
retained (remains 1) on the FT1A Touch, but will become 0 on the FT1J. 
 
1.4 Clear after download 

● Log Data 
FT1A Touch: Always clear. 
FT1J series: You can select whether to retain or clear the data log, alarm log, operation log, and data storage 

area only if the settings have not been changed. To clear data, select the check box for the data you 
want to clear in Clear the following data in the Download dialog box.  

 
● Ladder program execution error code (D8006) value 
FT1A Touch: Retained. 
FT1J series: Cleared. 
 
  

 
*1 For the FT1J series, there is no check box for Blink #TP/#CP on the Touch screen when the value in TP/CP is modified on the 

System tab of the Project Settings dialog box of WindO/I-NV4. 
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2 WindO/I-NV3 and WindO/I-NV4 
2.1 Ribbon > Configuration tab 

● Project > Project Settings dialog box > Contents tab 
WindO/I-NV3: Exists 
WindO/I-NV4: None 
After changing the series, the Description will be deleted. If necessary, use other settings such as Comment in the 
Project Details tab alternatively. 
 
2.2 Ribbon > Online tab 

● Upload 
WindO/I-NV3: The main unit does not reset after executing Project Data. 
WindO/I-NV4: The main unit resets after executing Project Data, then resumes operation. 
 
● Clear 
WindO/I-NV3: The value of the ladder program execution error code (D8006) will be retained even after executing 

All or Data of all Device Addresses. 
WindO/I-NV4: After executing All or Values of All Device Addresses, the value of D8006 is cleared. 
 
● Simultaneous monitoring with WindLDR 
WindO/I-NV3: Configure the communication interfaces separately and start monitoring with WindLDR and WindO/I-

NV3. (Example: USB for WindO/I-NV3, Ethernet for WindLDR) 
WindO/I-NV4: Start monitoring with WindLDR, then start monitoring with WindO/I-NV4. 
 
● Simulator 
WindO/I-NV3: None 
WindO/I-NV4: Exists (You can debug the HMI function settings on a PC even if you do not have the main unit.) 
 
● Communication 
WindO/I-NV3: Maintenance communication with O/I Link slave is possible via O/I Link master. 
WindO/I-NV4: Maintenance communication with O/I Link slave cannot be performed via O/I Link master. 
 
2.3 Protocol Manager 
The number of default templates are different. 
WindO/I-NV3: 4 
WindO/I-NV4: 1 
 
2.4 Screen window alignment 
In WindO/I-NV3, screen windows can be displayed side-by-side, but in WindO/I-NV4, they cannot be displayed side-
by-side. 
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2.5 Print Function 

Print functions have been greatly improved in WindO/I-NV4. You can set the print contents for the cover, screen, and 
each setting within the project. It also supports Word document output. 
 
2.6 Text Manager 
The UI has been redesigned in WindO/I-NV4. 
Even if the font is something other than "Windows", the text will be displayed in the selected font. Characters that 
are not supported by the selected font are displayed with a ? (question mark). 
 
2.7 Library Screen 
The library screen has been integrated into the part library. 
WindO/I-NV3: Library screen 
WindO/I-NV4: Part Library > Custom 
 
2.8 Grouping of object lists 
Objects look different when grouped. 
WindO/I-NV3: The "Group Start" and "Group End" lines are displayed. 
WindO/I-NV4: A collapse symbol and "Group" are displayed at the start position of the grouping. 
 
2.9 Setting characters and device addresses 

● Character 
The UI for entering Unicode characters into the items that set the characters to be displayed on the screen is 
different. 
WindO/I-NV3: Click the “>>” button and enter in the displayed Unicode Input dialog box. 
WindO/I-NV4: Direct input (always Unicode input) 
 
● Device Address 
In the item for setting the device address, the dialog box that is displayed when clicking the ... button is different. 
WindO/I-NV3: Device Address Settings dialog box 
WindO/I-NV4: Tag Editor 
 
2.10 Terms 
The changed terms are as follows: 

Item WindO/I-NV3 WindO/I-NV4 

Data types 

BIN16(+) UBIN16(W) 

BIN16(+/-) BIN16(I) 

BIN32(+) UBIN32(D) 

BIN32(+/-) BIN32(L) 

float32 Float32(F) 

BCD4 BCD4(B) 

BCD8 BCD8(EB) 

Ribbon > Online > Monitor Simulation Offline 
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2.11 Cartridge Settings 

The UI for setting cartridges is different on WindLDR. 
FT1A Touch: Cartridge in the Function Area Settings dialog box 
FT1J series: Module configuration editor 
 
2.12 System software version number 
The UI for checking the system software version number is different. 
FT1A Touch: Click Status in PLC on the Online tab of the WindLDR ribbon. Then check the displayed PLC 

Status dialog box. 
FT1J series: Click Target Info. under MICRO/I on the Online tab of the ribbon in WindO/I-NV4. Then check 

the displayed Target Information dialog box. 
 
2.13 Internal Clock 
The method for changing the date and time data of the internal clock is different. 
FT1A Touch: Click Status in PLC on the Online tab of the WindLDR ribbon. Then check the displayed PLC 

Status dialog box and click the change… button*1 within Operation Status, Calender. Another 
way is by using Special Data Register D8015 to D8021, or HMI Special Data Register LSD20 to 
LSD26. 

FT1J series: HMI Special Data Register LSD20 to LSD26 only 
 

3 Downloader and Data File Manager 
The compatible maintenance software is different. 
FT1A Touch: Downloader 
FT1J series: Data File Manager 
 
 

 
*1 Only valid when monitoring FT1A Touch 
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Chapter 7 References 
1 Terminal arrangement and wiring example 

For details about the terminal arrangement and wiring, refer to the Hardware Manual in " Related Documents"  
 
1.1 FT1A Touch 

● FT1A-*12RA-* 

 
● FT1A-*14KA-* 
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● FT1A-*14SA-* 

 
1.2 FT1J series 

● FT1J-4F12RAG-* 
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● FT1J-4F14KAG-* 

 
● FT1J-4F14SAG-* 
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2 Rules for Converting to the top layer 
Among overlaying objects, objects that meet certain conditions will be placed in the top layer after changing product 
series. However, this only applies to objects that are overlaying on the same screen; objects that are overlaying due 
to overlaying screens will not be included even if they meet the conditions. The conditions for conversion vary 
depending on the object. 
 
● Drawings 
Line, Polyline, Polygon, Rectangle, Circle/Ellipse, arc, Pie, Equilateral Polygons 
Condition: Flash check box is selected 
 
● Parts 
All parts 
If all of the following conditions are met: 
Condition 1: Another part (part B) is placed within the rectangular area of this part (part A). 
Condition 2: Part B operates before part A (it is at the top of the object list). 
Condition 3: Part B is placed on the top layer 
 
Pilot Lamp 
If all of the following conditions are met: 
Condition 1: The Recover background check box on the View tab is selected. 
Condition 2: Another drawing or part (object B) is placed within the rectangular area of this part (part A). 
Condition 3: Object B operates before part A (it is at the top of the object list). 
Condition 4: One or more of the following are satisfied: 

- "Flash(ON + Flash)" is set  
- A shape that includes a transparent color is set for "Picture" in the View tab 
- The Not Display Image check box is selected in the View tab 

 
Multi-State Lamp 
If all of the following conditions are met: 
Condition 1: The Recover background check box on the View tab is selected. 
Condition 2: Another drawing or part (object B) is placed within the rectangular area of this part (part A). 
Condition 3: Object B operates before part A (it is at the top of the object list). 
Condition 4: One or more of the following are satisfied: 

- Select "Picture" in the View tab, and a shape containing a transparent color is set in the State 
Setting dialog box opened from the State tab  

- The OFF state is set to None 
 
Picture Display 
If all of the following conditions are met: 
Condition 1: The Recover background check box on the View tab is selected. 
Condition 2: Another drawing or part (object B) is placed within the rectangular area of this part (part A). 
Condition 3: Object B operates before part A (at the top of the object list). 
Condition 4: One or more of the following are satisfied: 

- The Flash check box is selected on the General tab 
- The Dynamic Position check box is selected on the General tab 
- A shape that contains a transparent color is set on the View tab 

Condition 5: The Dynamic Size check box is unchecked on the General tab. 
 
 



 

   
Specifications and other descriptions in this document are subject to change without notice. 
Information in this document is current as of October, 2024. 
2024 IDEC Corporation, All Rights Reserved. 
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